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1. Introduction 
EDGE (Excellence in Design for Greater Efficiencies) is a standard, a green building certification and an online app 

of the International Finance Corporation (IFC). This document is part of a series of documents aimed at the 

global harmonization of the EDGE buildings certification process.  

In these documents, "Must" and "Shall" are used to prescribe obligatory actions. "Can" implies that there is an 

option or ability to do something, but it is not required. Lastly, "May" grants permission or suggests that an 

action is permissible, providing flexibility or discretion to the Project team. 

The main target group for this document are EDGE experts, EDGE auditors, EDGE Certifiers and anyone 

interested in learning more about the certification. 

The Part 1 – Building Certification Guidance document serves as a fundamental policy resource, offering 

instructions for certification, an overview of the certification procedure, and information on the types of 

buildings eligible for certification. This key document applies to all projects around the world and shall be used 

as the primary guide throughout the certification process. It is to be used in conjunction with Parts 2 to 6, which 

provide specific guidance on utilizing the EDGE App. 

Table 1 shows the relative position of this document within the set of EDGE user guides. When officially 

released, after the period for public comment, these documents shall replace EDGE User Guide Version 3.0.a. 

Table 1: Position of this document within the EDGE V3 modules. 

Module Overarching Design Energy Water Materials Operations 

App User 
Guides 

Part 1 – 
Building 
Certification 
Guidance 

Part 2 - User 
Guide -  
Design Tab 

Part 3 – User 
Guide - Energy 
Measures 

Part 4 – User 
Guide - Water 
Measures 

Part 5 – User 
Guide - 
Materials 
Measures 

Part 6 – User 
Guide 
Operations 

Building  
Certification 
Guidance 

     

Operations 
Certification 
Guidance 

     

Auditor  
Guidance 

 Part 8 – Auditor Guidance 

Methodology For future release 

Homes 
Prescriptive  
Certification 
Guidance 

Check country-specific documentation 

Note 1: The shaded modules are not applicable. 
Note 2:  All guidance and user guide documents are complimentary information to the EDGE protocol 
documents. 
Note 3: In the case of any discrepancy, the EDGE protocol document takes precedence   

To share feedback with the EDGE team, please send suggestions along with relevant documentation to 

edge@ifc.org.   

mailto:edge@ifc.org
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2. Glossary 
AHU  Air Handling Unit 

ARI  Air-conditioning and Refrigeration Institute 

ASHRAE American Society of Heating Refrigerating and Air-conditioning Engineers 

Btu  British thermal unit 

cfm  Cubic feet per minute (ft³/min) 

COP  Coefficient of Performance 

EDGE   Excellence in Design for Greater Efficiencies 

EPI   Energy Performance Index (kWh/m2/year) 

GIA  Gross Internal Area 

GJ  Giga Joules 

HVAC  Heating, Ventilation and Air-conditioning 

ISO  International Organization for Standardization 

kW  Kilowatt 

kWh  Kilowatt-hour 

MJ  Megajoules 

ppm  Parts per million 

SHGC  Solar Heat Gain Coefficient 

sqm  Square Meter 

STP  Sewage Treatment Plant 

TR  Tonnage of Refrigeration 

VLT  Visible Light Transmission 

VAV  Variable Air Volume 

VFD  Variable Frequency Drive 

VSD  Variable Speed Drive 

W  Watt  

Wh  Watt-hour 

WFR  Window-to-Floor Ratio 
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3. EDGE Certification  
EDGE certification is a green building certification system that is designed to promote resource-efficient and 

sustainable building practices. EDGE certification focuses on three key areas: energy, water, and embodied 

energy in materials. It provides a framework for evaluating and quantifying the environmental impact of a 

building, taking into account factors such as energy efficiency, water conservation, and the use of sustainable 

materials. 

3.1. EDGE Assessment and Certification Definitions 
▪ A building in EDGE is defined as a thermally conditioned (heated and/or cooled) or naturally ventilated 

structure with at least one full-time equivalent occupant, and a minimum area of 200m², except for 

residential typologies.  A building shall include water use for occupants, lighting and other services 

related to the use of the building. If two buildings are connected by a thermally conditioned space, then 

they may be considered as a single building. Notice that certain components of a building may be 

physically separate yet situated within the project boundary. Examples include a cafeteria and individual 

classrooms of a school that are essential for the functioning of the building as a whole. For questions 

about specific projects that do not fall within these limits, reach out to the EDGE team at edge@ifc.org. 

▪ A building envelope refers to the combined surface area of all components of a building that surround 

its thermally conditioned spaces. These components separate the interior from the external 

environment and do not include surfaces adjacent to other buildings. 

▪ A building footprint refers to the area of ground that a building occupies as defined by its perimeter. 

▪ A building site defines both the land parcel and the building(s) situated on it. 

▪ The project boundary defines the scope of the EDGE certification, including all services required to 

support the functionality of the building, including the area for on-site renewable energy. The project 

boundary area may be larger than the building footprint. 

▪ Project: A Project is defined as the whole building or development submitted for EDGE certification with 

the same certifier and owner. For example, a Project may be a residential building with two towers, a 

mixed-use building with offices and retail space, or multiple buildings with the same specifications in a 

city or country. The information in the Project section in EDGE is the top-level information that applies 

to the whole project. 

▪ Subproject: Refers to the portion of the project modeled individually in EDGE. The information 

contained in the Subproject section applies only to the portion being modeled in that file. For example, a 

Subproject may be Unit Type 1 in a residential building, the retail space in a mixed-use tower, or an 

individual location for a chain of stores. 

If a building has more than one use and the secondary use occupies less than 10% of the floor area up to 

a maximum of 1,000m², the entire building can be certified under the primary use of the building in a 

single subproject. Otherwise, that portion shall be certified separately. For example, if a 10,000m² 

residential building has a retail portion of 1,200m² located within the ground floor, the building areas 

must be certified separately under the Homes and Retail typologies.  

For grouping of multiple buildings into one subproject, refer to section 3.5.2 Grouping Multiple Buildings 

into One Subproject. 

mailto:edge@ifc.org
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Figure 1. Relationship between project and subprojects. 

 

3.2. EDGE Certification 
EDGE certification is awarded if the required minimum efficiencies of 20% are achieved in the three EDGE 

categories — Energy, Water, and Materials. A simple pass/fail system indicates whether the building project has 

demonstrated the minimum 20% savings in operational energy, water and embodied energy in materials 

compared to the base case model. Actual percentage savings for each project can be seen on the EDGE 

certificate as well as in project case studies on the EDGE website. Beyond EDGE certification, EDGE also offers 

EDGE Advanced for 40% energy savings, with water and material savings remaining at 20%, as well as EDGE Zero 

Carbon certification. The entire certification process is conducted online through the EDGE software. 

EDGE certification is a one-time award that does not need to be renewed. Recognition is issued automatically at 

the time of the awarding of a preliminary EDGE certificate and/or final EDGE certification and indicated on the 

EDGE certificate for such a project; it does not require additional documentation or fees. 

3.2.1. EDGE Advanced Certification 
EDGE Advanced status indicates that an EDGE project has achieved 40% or greater savings in Energy, beyond 

the minimum EDGE certification requirements. To meet the requirements for water savings and savings in 

embodied carbon of materials, a minimum of 20% savings over the base case is still necessary. 

3.2.2. EDGE Zero Carbon Certification 
The EDGE Zero Carbon certification provides clients with a pathway to certify that the operations of a building 

are zero carbon. The prioritization for achieving a Zero Carbon project is described in Figure 2: initially, enhance 

energy efficiency by reducing demand with passive design strategies. Subsequently, fulfil the remaining energy 

requirements using efficient building services. Next, maximize the generation of renewable energy on-site, 

followed by supplementing with renewable energy generated off-site. Utilizing carbon offsets shall be 

considered a last resource after all other options have been exhausted. 

 

Figure 2: Prioritization of energy efficiency and energy sources to achieve the EDGE Zero Carbon certification. 
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3.2.3. Eligibility Requirements 
There are three requirements for projects to be eligible for EDGE Zero Carbon certification:  

1. The building type must be among those that are included in the EDGE App:  
a. Residential: Homes & Apartments  
b. Serviced Apartments  
c. Hotels & Resorts  
d. Hospitals  
e. Industrial  
f. Offices  
g. Education  
h. Retail  
i. Mixed Use  

 
Note: For residential typologies the entire subproject must pursue EDGE Zero Carbon, rather than 
individual units. 

  
2. A building must have been in operation for at least one year at 75 percent of normal occupancy.  

  
3. A building must be certified as EDGE Advanced, which requires a minimum of 20 percent savings in 

water and embodied energy in materials and 40 percent savings in energy:  
a. For projects already certified EDGE without achieving EDGE Advanced, projects must first re-

apply to achieve EDGE Advanced using the latest EDGE version. 
b. For projects not previously certified with EDGE, EDGE Advanced must first be achieved using the 

latest EDGE version before EDGE Zero Carbon certification can be pursued.  
 

3.2.4. Reporting Timeline 
The EDGE Zero Carbon certification timeline is presented in the reporting period must include data from 12 

consecutive month. The EDGE Zero Carbon certification must start within 6 months of the last reporting month. 

 

Figure 3. EDGE Zero Carbon Certification Timeline 

For example: Reporting period from January 2023 to December 2023 must apply for EDGE Zero Carbon 

Certification by June 2024. 
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3.2.5. Documentation Requirements 
When obtaining EDGE Zero Carbon certification for a project, gather the following information:  

A. Proof of 40 per cent energy savings from the EDGE baseline: Download, save and provide a PDF of the 
EDGE Advanced certificate for the project from your dashboard in the EDGE App that demonstrates 
EDGE Advanced status. This is a one-time assessment of the asset that will not need to be provided at 
the time of recertification unless the building undergoes substantial changes such as occupancy 
changes, a significant addition (more than 10 per cent of the Gross Internal Area, or GIA) or a major 
renovation.  

B. Reporting period: The reporting period shall be as per 3.2.4 Reporting Timeline 

C. Declaration of occupancy: A signed declaration by the project owner or their authorized representative 
that the project has been occupied at 75 per cent of expected occupancy for the reporting period.  

D. Project area: Building plans showing the GIA – air-conditioned and un-air-conditioned – of the building, 
and the total GIA for input into the calculator. The GIA does not include balconies and terraces, exterior 
areas or site areas. The EDGE project’s PDF report showing the GIA and the project file number will be 
sufficient for verification.  

E. Operations Tab – Completed: All energy use information must be entered into the EDGE Operations 
Tab. The data entered in the Operations Tab in the EDGE App must have supporting documentation 
attached.  

F. Energy bills and meter readings: Monthly Bills or readings for the reporting period for every source of 
energy used in the building. The bills or meter readings must be for 12 consecutive months.  
  
Supporting documentation shall be submitted for each month, and must include the following, as 
relevant:  

▪ Conventional Electricity Bills (kWh)  
▪ Onsite Renewable Energy Generated, Consumed and Exported (kWh) – Meter or 

Building Management System Readings. The type of onsite renewable energy (e.g. solar, 
wind, etc.) must match the EDGE Advanced documentation.  See Note 1. 

▪ Offsite Renewable Electricity Bills (kWh). The type of offsite renewable energy (e.g. 
solar, wind, etc.) shall be highlighted. See Note 2. 

▪ Bills indicating the quantity of diesel used on site (in Liters)  
▪ Bills indicating the quantity of LPG used on site (in kg)  
▪ Bills indicating the quantity of natural gas used on site (in m3)  

  
Energy bills must cover twelve continuous months from the intended start date. For electricity produced 
on-site, documentation may include readings from the BMS, smart monitoring system or renewable 
system meter (such as the inverter in a solar system).  
 
Note 1: On-site renewable energy systems must be within the project boundary. Additionally, the 
building owner must either own the renewable energy system, have a lease for them, or have entered a 
contract to buy the energy they produce for a minimum duration of 15 years. 
 
Note 2: Off-site electricity purchased with a lower carbon content than the conventional grid, shall 
comply with ISO 14067 emissions reporting principles including relevance, completeness, consistency, 
coherence, accuracy, transparency, and avoidance of double counting, among others. Examples of 
offsite renewable energy options are RECS/I-RECs or Power Purchase Agreements (PPAs). 
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G. Purchased carbon offsets: Carbon offset certificates or proof of purchase of carbon offsets (in tCO2e). If 

applying carbon offsets, they shall be purchased from a provider that: 

1. Requires the use of a credible methodology, such as:   

▪ Gold Standard  

▪ Verra’s Verified Carbon Standard   

▪ ACR: Carbon Crediting Program for Offsets 

▪ Climate Action Reserve 

Note: ClimateSEED and UNFCCC Clean Development Mechanism (CDM) have been removed from 

the list to align with IFC’s Deal Acceptance Criteria for Carbon Markets. 

2. Adhere to the ten core carbon principles set by the Integrity Council for Voluntary Carbon Markets 

(ICVCM), where applicable; 

3. Favor Independent Carbon Rating Agencies for quality assessment, and 

4. Have a benefit-sharing plan.  

 

3.2.6. Documentation Submission 
All energy use information must be input into the EDGE Carbon Calculator, which is incorporated into the EDGE 

App. Supporting documentation shall be uploaded into the EDGE App in the Operations tab.  

 

3.2.7. Certification Expiration 
The EDGE Zero Carbon certificate will display the year of awarding and expiration according to the following:  

▪ For a project that meets the EDGE Zero Carbon criteria fully on-site, including the generation of on-site 

renewable energy, the certificate will expire after four years.   

▪ For a project that meets the EDGE Zero Carbon criteria by purchasing off-site renewable electricity 

and/or carbon offsets, the certificate will expire after two years.  

▪ The EDGE Zero Carbon certification is rendered invalid when there is a transfer of ownership of the 

building or the building undergoes significant occupancy changes or substantial changes (as defined in 

section 3.2.5). 

 

3.2.8. Recertification 
A project that has been previously certified as EDGE Zero Carbon can undergo EDGE Zero Carbon Renewal (ZCR) 

to maintain its EDGE Zero Carbon status with the following conditions.  

A. Maintain EDGE Advanced certification:  

▪ If the building has not had substantial changes (as defined in 3.2.5) since the last EDGE Zero 

Carbon certification the project owner or their designated representative must provide a signed 

statement to that effect.  

▪ If the building has had substantial changes (as defined in 3.2.5), the project team must show 

that the energy savings of the building are 40 percent in the EDGE App. Note that the EDGE 

baseline is revised every few years as construction standards change. 

B. Annual records of performance: The project must submit annual records of information similar to that 

submitted for the original EDGE Zero Carbon certification (see A to G from Section 3.2.5). For prior years, 

provide: 
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▪ Start date  

▪ Energy bills and meter readings for energy purchased and produced  

▪ Carbon offset certificates  

 

3.2.9. Retrofit Projects 
EDGE Zero Carbon retrofit projects follow the same guidelines as those for new construction and existing 
buildings. However, rather than having achieved EDGE Advanced, they have a defined plan to reach the 
necessary energy efficiency levels within a specified timeframe instead. 
  
For projects that are already purchasing offsite renewable energy and/or carbon offsets, a retrofit project may 
apply for a Preliminary EDGE Zero Carbon certification before achieving post construction EDGE Advanced 
certificate under the following conditions:  

▪ A preliminary EDGE Advanced certificate must be achieved.  

▪ The retrofit project must demonstrate its work plan — via a Preliminary EDGE Advanced 

certification— on how it will achieve EDGE Advanced when the retrofit is complete.  

▪ The project owner must provide a signed letter that the retrofit measures will be implemented 

within two years of the award of the Preliminary EDGE Zero Carbon certification, and  

▪ The project must achieve carbon neutrality via the purchase of offsite renewable energy or 

carbon offsets in the interim when it is certified as a Preliminary EDGE Zero Carbon project.  

When a retrofit project that is pending a final (post construction) EDGE Advanced certificate, the Preliminary 
EDGE Zero Carbon certificate will show that:  

▪ The project is pending upgrades, and   

▪ The certificate is valid for two years.  

At the end of the two-year period, the project must have achieved final EDGE Advanced certification. If not, the 
project will lose its Preliminary EDGE Zero Carbon. The project will not be eligible to re-apply until it achieves 
EDGE Advanced status.  
 

3.3. Project Roles 

3.3.1. Project Team/EDGE Experts 
In the EDGE certification system, a project owner is the designated owner or owner’s representative responsible 

for the entire project including providing project documentation, access to the site, and the payment of audit 

and certification fees. An EDGE Expert is an individual certified in the use of EDGE software and certification 

process; they may be part of the owner’s organization or an independent service provider.  

The project owner designates a project team (which may include an EDGE Expert) whose role is to demonstrate 

that the project complies with the EDGE standard. The project team achieves this by documenting that the 

overall project and the selected individual measures meet the specifications and minimum performance 

required by EDGE.  

Four distinct user roles for an EDGE project team are available in the EDGE software to represent the typical 

certification software responsibilities.  

1. A Project Owner can assign or remove any user role and create/edit/delete projects in the EDGE 

software.  
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2. A Project Admin is the EDGE Expert or a trained EDGE user who manages the certification flow of the 

project on behalf of the owner.  

3. A Project Editor is typically someone from the design team who can edit the project details and 

documentation.  

4. A Project Viewer can track the project’s progress without the ability to edit. 

 

3.3.2. EDGE Auditors 
EDGE Auditors are EDGE Experts who have been further accredited to conduct project audits for EDGE 

certification. The role of the EDGE Auditor is to verify that the design/construction team has interpreted the 

EDGE requirements correctly and that all compliance requirements have been fulfilled. Depending on the 

country and the certification provider, an EDGE Auditor may be part of the EDGE Certifier’s team or hired 

independently. In either case, the project owner is responsible for the EDGE Auditor fees.  

The EDGE Auditor reviews the supporting evidence provided by the project team to ensure that it matches the 

data used in the assessment and performs on-site audits. Auditors must verify 100% of the floor area for a 

unique design for any building type. In the case of repetition in design, an auditor must verify the following at a 

minimum: 

▪ Homes, Apartments    (square root of the number of units) +1, for each type 

▪ Hotels, Resorts, Serviced Apartments (square root of the number of rooms) +1, for each type 

▪ Healthcare      (square root of the number of rooms) +1, for each type 

▪ Retail, Industry, Office, Education   40% of similar areas for a project 

▪ Mixed Use     Each use type to follow the respective rules from above 

▪ Multiple buildings of the same type:  (square root of the number of buildings) +1, for each type 

 

3.3.3. EDGE Certifiers 
EDGE Certifiers are licensed by IFC to operate in designated countries. Their role is to oversee EDGE Auditors 

and issue the EDGE certificates. Information on contacting local certifiers is available on the ‘Certify’ page at 

www.edgebuildings.com. The project owner is responsible for paying the certification fees to the EDGE Certifier. 

 

3.4. EDGE Certification Process 
The certification process involves auditing the project documentation submitted by the project team and a site 

audit, followed by the award of the certificate. Requirements for EDGE compliance, at both the preliminary and 

post-construction phases, are specified for each measure in this guide, and include such deliverables as design 

drawings, manufacturers’ data sheets, calculations, proof of delivery and photographs.  

Preliminary Certification: A desktop review of the project is undertaken based on the project’s design 

documentation. 

Post Construction Certification: A site audit of the project is required for the EDGE Auditor to verify the 

installation and compliance requirements of all selected measures in EDGE. 

http://www.edgebuildings.com/
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All audits shall be conducted by an accredited EDGE Auditor, with certification being awarded by a licensed 

EDGE certification provider. 

 

Figure 4. EDGE Certification Process. 

To begin the certification process, the project owner/EDGE Expert may request a quote from the local 

certification provider via the Certify page on the EDGE buildings website; they may also ‘Express Interest’ via the 

EDGE software to request a quote from the certifier or local auditor(s). Or a project may choose to directly 

‘Register’ in the EDGE App. 

3.4.1. Documentation Requirements 
Subproject-level documentation is uploaded to the EDGE App. In general terms, the following documents, where 

relevant, are required to demonstrate compliance: 
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▪ Design documentation showing (intended) compliance with the requirements of the measure. 

▪ Technical justification of the inputs provided in the design tab that creates the base case. 

▪ A brief explanation of the design drawings, relevant system or product specified/installed. 

▪ Calculations that have been used to assess and demonstrate compliance.  

▪ Manufacturer’s data sheets, with the information required to demonstrate compliance 

highlighted. 

▪ Construction Documentation, such as as-built drawings, BOQs and/or photographs that 

demonstrate the construction was as per the design documentation. 

The documentation required for subsections in the design tab can be found in Part 2 - User Guide - Design Tab 

The documentation required for individual measures is included in the Compliance Guidance section of each 

measure in: 

▪ Part 3 – User Guide - Energy Measures 

▪ Part 4 – User Guide - Water Measures 

▪ Part 5 – User Guide - Materials Measures 

The operational documentation required for Zero Carbon measures can be found in section 3.2.5 

 

3.5. Non-Typical EDGE Projects 

3.5.1. Special Ruling Request (SRR) 
A Special Ruling Request (SRR) is a mechanism for project teams to request a special ruling on the eligibility of a 

method or measure that has not been included in the EDGE App, to determine compliance with EDGE. This is 

applicable for situations where project teams may want to (1) use an alternative method to comply with the 

intent of an EDGE Measure, or (2) use innovative strategies not included in the available EDGE Measures to 

reduce resource consumption in Energy, Water or Materials. For example, an SRR would be required for using 

an alternate tool outside EDGE to calculate the Average Annual Shading Factor (AASF) or to calculate the savings 

from a cooling system type that is not available in EDGE.  

The SRR form formally documents for audit purposes that a project team has received special permission from 

IFC’s EDGE team to use an out-of-the-norm procedure for claiming measure savings in the EDGE App. Actual 

compliance with the intent of the measure will still be subject to an audit.  

Note that the SRR is a means of formal documentation for audit purposes only. In general, the EDGE User Guides 

and the Frequently Asked Questions available on the EDGE website serve as a starting point for questions 

related to the EDGE certification of projects. Further questions about EDGE project measures and certification 

can be directed to the respective EDGE Certification Provider selected for the project. In addition, the IFC EDGE 

team is available to help at edge@ifc.org.  

If a project team has gone through the steps above and still needs documentation of approval for an atypical 

approach to its project, it can request a Special Ruling Request form from the certifier.  

An SRR is project-specific. When the content is universally applicable, it will be added to the User Guide and not 

require an SRR for compliance anymore. 
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Note: Projects submitting an SRR shall be registered, i.e. SRRs submitted for projects in self-review will not be 

assessed. 

3.5.2. Grouping Multiple Buildings into One Subproject 
To group physical buildings into a single subproject, the following criteria must be met: 

▪ Construction occurs in a single phase, or the buildings are fully constructed. 

▪ A single entity manages and operates the heating, cooling, ventilation, and hot water services. 

▪ The buildings operate on the same days and have similar operating hours, with less than a three-hour 

difference. 

▪ The same or similar systems primarily condition them. While tenants may have their cooling systems, 

the core and shell of the building shall include all areas served. 

▪ All users are expected to utilize all the facilities provided regularly. 

▪ Be the same sub-typology (unless spaces can be modelled in another sub-typology) 

▪ They shall have a standard deviation of up to 2 floors or 10% normalized, whichever is higher. 

Buildings being combined shall: 

▪ Use the EEM01 window-to-wall ratio detailed calculator. 
▪ Use the weighted average for the floor-to-floor height and number of floors by area. 
▪ Add up all the building envelope lengths by orientation. 
▪ Add up all the roof areas into one. 

 
Note 1: Each subproject will receive a single certificate (except homes and apartments). 

Example of standard calculation deviation 

Building A: 5 Floors    Building B: 7 floors    Building C: 3 floors 

To calculate standard deviation: 

𝑆𝑡𝑎𝑛𝑑𝑎𝑟𝑑 𝑑𝑒𝑣 (𝑓𝑙𝑜𝑜𝑟𝑠)

=  √
∑(𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑓𝑙𝑜𝑜𝑟 𝑝𝑒𝑟 𝑏𝑢𝑖𝑙𝑑𝑖𝑛𝑔 −  𝑎𝑣𝑒𝑟𝑎𝑔𝑒 𝑓𝑙𝑜𝑜𝑟𝑠)2

𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑏𝑢𝑖𝑙𝑑𝑖𝑛𝑔𝑠

= √
8

3
= 𝟏. 𝟔𝟑 𝒇𝒍𝒐𝒐𝒓𝒔. 

To calculate the normalized standard deviation: 

𝑁𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑒𝑑 𝑆𝑡𝑎𝑛𝑑𝑎𝑟𝑑 𝑑𝑒𝑣 (%)

=
𝑆𝑡𝑎𝑛𝑑𝑎𝑟𝑑 𝑑𝑒𝑣 (𝑓𝑙𝑜𝑜𝑟𝑠)

 𝑎𝑣𝑒𝑟𝑎𝑔𝑒 𝑓𝑙𝑜𝑜𝑟𝑠
 𝑥 100%

=  
1.63

5
 𝑥 100% = 𝟑𝟑. 𝟕%  

This means building A, B and C cannot be grouped into a subproject 

due to Normalized Standard Deviation being >10%. 
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Note 2: The project team may decide to create separate subprojects even if they meet the conditions above. 

This is especially relevant when more granularity in the EDGE App is required to better assess the impact of 

measures. 

Note 3: Thermally conditioned basements that have a significantly larger footprint (i.e., >10% of building 

footprint) compared to the building tower shall be separated into a different subproject. Partially conditioned 

basements that have >10% of the building footprint, with the conditioned space within the building footprint, 

will not be required to have a separate subproject. 

 

3.5.3. Existing Building and Retrofit Projects 
Existing buildings may apply for EDGE certification. The same standards for energy and water apply to existing 

buildings as for new construction.  

Existing building and retrofit projects that do not have details on the building element construction shall use the 

thickness of the wall and provide a calculation using the default base case, e.g. brick walls with no insulation. 

The same applies same for roofs and other passive elements. 

Materials in existing buildings that are being kept in the building or re-used and are older than five years may be 

claimed as “re-used.” (This applies to re-use of materials older than five years in new construction as well). To 

claim a building as existing and/or to claim re-use of materials, the project team must provide documentation 

from the formal local source that shows the date when the building was constructed or last modified. For 

example, the formal source in a location may be a building department and the documents may be drawings 

stamped by the building department. Pictures of the existing building and materials shall also be provided as 

evidence.  

Note: Existing buildings and Retrofit projects have the same calculation methodology in the EDGE app. 

3.5.4. Reporting Equipment Loads from Existing Buildings 
For existing buildings and major renovations that are currently in operation, it is highly recommended to report 

equipment and plug loads, as shown in Figure 5. This practice helps to reduce discrepancies between the 

expected and the actual loads. By doing so, the predictive accuracy of the EDGE App is enhanced, leading to 

better-informed decision-making.  

 

Figure 5: Plug and Equipment Loads in the Detailed Loads Input. 
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Note: For detailed information on each of the columns editable by the project teams, consult Part 2 - User Guide 

-Design Tab - Detail Load Inputs. 

To do so, the Project team shall follow these steps: 

1. Inventory Equipment: Create a detailed inventory of all equipment in the building that consumes 

energy, including HVAC systems, lighting, appliances, office equipment, and any specialty equipment. 

2. Record Specifications: For each piece of equipment, record detailed specifications such as make, model, 

power rating (watts or kilowatts), and operational schedules. This information can often be found on the 

equipment nameplate or in the manufacturer's documentation. If the number of equipment units is 

large (e.g. > 50 pumps), Annex 1: Sampling Methodology may be used. 

3. Calculate Loads: Use the recorded power ratings to calculate the load of each piece of equipment. For 

variable loads or equipment that cycles on and off, estimate the average load based on typical usage 

patterns. 

4. Summarize Data: Organize the equipment loads in a spreadsheet, categorizing them by type and 

including subtotals for each category. 

5. Apply Diversity Factors: Not all equipment will operate at full capacity simultaneously. Apply diversity 

factors to account for such variation in use. If this value is not known, assume 0.5. 

6. Calculate electricity use by area: Divide the resulting loads (in Watts) by the corresponding space area 

(m2). Provide such value in the corresponding column (Plug Loads or Equipment Loads) in the Detailed 

Loads Input. 

The plug and equipment loads report shall be attached as part of the documentation in the Design tab section, if 

applicable. 

3.5.5. Core & Shell and Partially Unfinished Projects 
Core and Shell are commercial and/or industrial projects where the owner is responsible for the building 

exterior (“shell”) and the core facilities (“core”), but the interior areas are constructed by the tenants (“fit out”). 

The owner or developer must certify the entire space they own/develop.  

For Core and Shell projects, the measures for which the tenants are responsible can also be claimed in EDGE as 

per those shown in Annex 2: Core & Shell measures.  

In commercial buildings, this is allowed only if a “tenant fit-out guide” is included in the lease agreement and 

signed between the tenants and owners. This tenant fit-out guide must define the requirements to be fulfilled 

by the tenants for the measure and be included in the EDGE submission. If some of the tenants have not signed 

a lease at the time of EDGE certification, the building owner must show EDGE compliance by providing the 

template of the lease agreement accompanied by a signed letter stating that the tenant fit-out guide in the 

template lease agreement will be included in all tenant lease agreements signed for the building.  

Residential projects that do not provide fit out installations and finishes are not considered Core and Shell but 

Partially finished projects and have different considerations found in Annex 3: Unfinished/Partially finished 

projects. 
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3.5.6. Partial Building Projects 
A part of a commercial building may apply for EDGE certification provided that the space has control of the 

HVAC system (both primary cooling system and distribution system). Both residential and industrial projects 

cannot apply for partial building certification. 

 

Partial building projects may be either owner led, or tenant led:  

▪ For owner-led certification, the owner must certify all areas within the building that are under the same 

ownership.  

▪ For tenant-led certification, the tenant must certify all areas that are part of their lease agreement. 

Certification of the tenanted area shall expire upon the departure of the tenant from the certified area. 

The certification of partial building projects shall: 

1. have occupancy requirements;  

2. be fully sub-metered (at least for electricity); 

3. be capable of having an independent user schedule, to other spaces; 

4. have water consumption requirements; and 

5. be physically defined by a physical and permanent barrier, e.g. by walls (interior and/or exterior). 

 

For partial building projects, the following EDGE App entries must be made, as applicable: 

▪ For the building envelope, the external wall lengths, materials, and WWR ratio shall represent the actual 

space applying for certification.  

▪ Buildings that have walls that are not exposed to the exterior shall subtract the portion of the wall that 

is not exposed. 

▪ The project team shall enter the ceiling area as its roof area. If there are floors located above the 

project, a U value of 0.01 shall be entered in EEM05: Insulation of roof. If the project is located on the 

topmost floor, the actual U value of the roof shall be entered in EEM05: Insulation of roof. 

▪ If the space under the floor of the space is considered permanently conditioned, the bottom floor U 

value shall be 0.01. If the certification area is at the bottom floor, the bottom floor U value must be 

used, if known, use the Base case U value otherwise. 

▪ Bathroom fixtures and fittings may not be within the building, but they may be in the project boundary. 

In this scenario, the project team must obtain water consumption data (flush rates, flow rates) of all 

shared facilities. Should these data not be available, the project team must perform an onsite 

measurement. If faucets and flush measurements cannot be measured, then the base case values may 

be used. 

▪ Projects that may not have bathrooms (i.e., shared toilets) may enter ‘0’ for the toilet area.  The EDGE 

app calculates water demand based on occupancy and will assume consumption without including areas 

that are not part of the certification.  

 

3.5.7. Industrial Buildings 
Unlike most building typologies, for industrial buildings, there is no assumption of business as usual related to 

process loads, i.e. equipment and plug gains. The Project team shall actively document each of the relevant 

loads and provide them to the EDGE app. The Project boundary includes everything in the manufacturing 

process, including anything that is outside the building and building site. 



 

© International Finance Corporation 2024. All rights reserved.    EDGE Part 1 – Building Certification Guidance, Pg 18  

Draft - For Public Comment 

In order of importance, project teams shall either: 

1. Provide an equipment schedule following steps in 3.5.4, where buildings are fully operational at the time 

of the certification, if this option is not possible, then; 

2. Calculate the process loads by estimating equipment gains for similar industrial subtypes (usage) in the 

region and/or the client’s own portfolios; or 

3. Assume:  

▪ For the warehouse subtypology, 35% of the GIA as “cold storage” space. 

▪ For the light industry subtypology, 70% of the equipment loads contribute to the total energy 

consumption of the base case scenario (i.e., prior to the implementation of on-site renewable 

energy sources). 

3.6. Data Centers 
EDGE offers project teams the opportunity to certify data centers as green. This certification is still in the pilot 

phase. Any data center globally, new or existing, is eligible to apply. There are two requirements for data centers 

to be eligible for EDGE certification: 

1. The datacenter must achieve a minimum of 20 percent savings in Water and Embodied Energy in 

Materials as per the EDGE standard.  

2. The Power Usage Effectiveness (PUE) of the data center must be at least 20% better than the baseline 

PUE, where  

𝑃𝑈𝐸 =  
𝑇𝑜𝑡𝑎𝑙 𝑎𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑒𝑛𝑡𝑒𝑟𝑖𝑛𝑔 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎 𝑐𝑒𝑛𝑡𝑒𝑟 𝑚𝑒𝑎𝑠𝑢𝑟𝑒𝑑 𝑎𝑡 𝑖𝑡𝑠 𝑏𝑜𝑢𝑛𝑑𝑎𝑟𝑦 

𝐴𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑢𝑠𝑒𝑑 𝑏𝑦 𝑡ℎ𝑒 𝐼𝑇 𝑒𝑞𝑢𝑖𝑝𝑚𝑒𝑛𝑡 𝑖𝑛𝑠𝑖𝑑𝑒 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎𝑐𝑒𝑛𝑡𝑒𝑟
 

EDGE utilizes the PUE (power usage effectiveness) as the energy baseline for data centers. PUE is a metric 

defined by The Green Grid that describes how efficiently a data center uses energy. It is a ratio of the total 

amount of energy used by a facility to the energy delivered to IT equipment.  

The baseline PUE values used in EDGE are shown in Table 2. These values are subject to change after the pilot 

phase.  

Table 2: Baseline and Target PUE per Climate Type. 

Climate Type Baseline 
PUE 

Target PUE for 
EDGE Certified (20% 

improved) 

Target PUE for EDGE 
Advanced (40% improved) 

Target PUE for EDGE Zero 
Carbon Certification 

Hot & Humid Climate 
(ASHRAE Climate 
Zones 1A, 2A, 3A) 

1.95 1.56 1.17 
(1.36 excluding offsite 

renewable energy) 

1.17 
(1.36 excluding offsite 

renewable energy) 

Other Climate Zones 1.81 1.45 1.09 
(1.27 excluding offsite 

renewable energy) 

1.09 
(1.27 excluding offsite 

renewable energy) 

Data centers with 20% improvement in PUE will achieve EDGE Certified status and data centers with 40% 

improvement in PUE will achieve EDGE Advanced status. 

3.6.1. Documentation Submission 
The data center project can use the following guidelines to show compliance with the EDGE standard: 

A. The project shall use the Mixed Use building type. 

https://www.thegreengrid.org/
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B. Onsite renewable energy can count toward contribution to PUE.  

 

PUEonsite RE, which includes onsite renewable energy, shall be calculated with the following equation for 

onsite renewable energy:  

 

 

𝑃𝑈𝐸𝑜𝑛𝑠𝑖𝑡𝑒 𝑅𝐸 =
𝑇𝑜𝑡𝑎𝑙 𝑎𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑒𝑛𝑡𝑒𝑟𝑖𝑛𝑔 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎 𝑐𝑒𝑛𝑡𝑒𝑟 − 𝑎𝑛𝑛𝑢𝑎𝑙 𝑜𝑛𝑠𝑖𝑡𝑒 𝑟𝑒𝑛𝑒𝑤𝑎𝑏𝑙𝑒 𝑒𝑛𝑒𝑟𝑔𝑦 𝑝𝑟𝑜𝑑𝑢𝑐𝑡𝑖𝑜𝑛

𝐴𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑢𝑠𝑒𝑑 𝑏𝑦 𝐼𝑇 𝑒𝑞𝑢𝑖𝑝𝑚𝑒𝑛𝑡 𝑖𝑛𝑠𝑖𝑑𝑒 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎 𝑐𝑒𝑛𝑡𝑒𝑟
 

 

C. PUERE, which includes renewable energy, shall be calculated with the following equation for onsite and 

offsite renewable energy:  

 

𝑃𝑈𝐸𝑅𝐸 =  
𝑇𝑜𝑡𝑎𝑙 𝑎𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑒𝑛𝑡𝑒𝑟𝑖𝑛𝑔 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎 𝑐𝑒𝑛𝑡𝑒𝑟 − 𝑎𝑛𝑛𝑢𝑎𝑙 𝑜𝑛𝑠𝑖𝑡𝑒 𝑟𝑒𝑛𝑒𝑤𝑎𝑏𝑙𝑒 𝑒𝑛𝑒𝑟𝑔𝑦 − 𝑎𝑛𝑛𝑢𝑎𝑙 𝑜𝑓𝑓𝑠𝑖𝑡𝑒 𝑟𝑒𝑛𝑒𝑤𝑎𝑏𝑙𝑒 𝑒𝑛𝑒𝑟𝑔𝑦

𝐴𝑛𝑛𝑢𝑎𝑙 𝑒𝑛𝑒𝑟𝑔𝑦 𝑢𝑠𝑒𝑑 𝑏𝑦 𝐼𝑇 𝑒𝑞𝑢𝑖𝑝𝑚𝑒𝑛𝑡 𝑖𝑛𝑠𝑖𝑑𝑒 𝑡ℎ𝑒 𝑑𝑎𝑡𝑎 𝑐𝑒𝑛𝑡𝑒𝑟
 

 

Offsite renewable energy can count toward contribution to PUE only for EDGE Advanced certification 

and EDGE Zero Carbon for a maximum of 10% with respect to the PUE baseline, see  Table 2 

 

D. The total improvement in PUE can be modeled using “EEM34 – Other Energy Saving Measures” 

 

a. Perform annual PUE calculations or simulations if the project is in design stage. 

b. Enter the percentage improvement in PUE compared to the baseline as the input for the 

measure RTE31 or EEM34 in EDGE. Savings to be reported are calculated as follows: 

1 – (PUEimproved case /PUEbaseline) 

c. Select applicable energy efficiency measures EEM34 (if necessary) to match the overall energy 

savings stated in the PUE report. Water and Materials tabs are completed as any other project. 

d. In the EDGE app under the Design tab modify the detail loads input calculator to reflect the IT 

equipment load as close as possible to the PUE report results. 

e. Upload evidence and external calculations in the measure documentation of all selected 

measures. 

f. The project’s EDGE Auditor shall send a copy of the PUE report to IFC (edge@ifc.org) for review 

and approval before recommending the project for certification. 

 

E. PUE shall be calculated using PUE Category 2 as defined by “ISO/IEC 30134-2:2016 Information 

technology — Data centers — Key performance indicators — Part 2: Power usage effectiveness (PUE)”.  

a. Readings must be made as total kWh over a 12-month period. 
b. All fuel types serving the data center must be converted to equivalent kWh. 

 

F. The PUE report shall include details of all the inputs and assumptions that were used in the simulation: 

c. Weather file  
d. Building construction and fenestration details (U-values, SRI, WWR, etc.) 
e. Lighting power densities 
f. Occupancy, lighting, and equipment profiles 
g. Indoor temperature and humidity set points 
h. HVAC systems details (capacity, efficiency, part load performance etc.) 

mailto:edge@ifc.org
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G. The post-construction evidence needed shall include: 

a. As-built drawings showing envelope and fenestration details and calculations of: 
i. Glass: U-value (W/m2 K), SHGC, VT(Factor). 

ii. Floors: U-value (W/m2 K), Weighted Average U-value (W/m2 K), if applicable 
iii. Roofs: Roof Assembly U-value (W/m2 K), Weighted Average Roof U-value (W/m2 K), if 

applicable 
iv. Exterior Walls: U-value (W/m2 K), Weighted Average Roof U-value (W/m2 K), if 

applicable 
v. Window-to-wall ratio: Average WWR (%) 

b. As-built drawings and data sheet showing room loads per areas, include occupancy and lighting 
power density assumptions. 

c. As-built load schedule showing, including (when applicable): model, quantities, power input, 
electrical characteristics, capacity, location, COP. Examples of equipment include: 

i. FCUs 
ii. Make up air units 

iii. Air handling units 
iv. Air conditioning units 
v. Chillers 

vi. Water pumps 
vii. Chilled water coils 

viii. Fans and blowers 
ix. Fuel oil bulk storage tank 
x. Air separator 

xi. Expansion tank 
d. As-built PUE calculation table showing: 

i. Annual energy used by the IT equipment inside the datacenter (kWh). Proof that it is the 
same as the total IT demand load calculated for capacity planning. 

ii. The annual facility load calculation (kWh). Include a facility load breakdown, for 
example: 

1. Lighting 
2. Cooling system (e.g., SPLCs) 
3. Chillers 
4. Chilled water pumps 
5. Condenser water pumps 
6. Coil/Fan Walls 
7. AHUs/FCUs/CUs 
8. Fans 
9. PDUs and transformers 
10. Transformers 
11. General losses (transformer, distribution, generator, UPS, switches, etc.) 

4. Navigating the EDGE App 
 

The EDGE App is designed with a simple, user-friendly interface. This section highlights a few key features. 
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The EDGE App loads in the Homes typology by default. A user can select a different typology from the sidebar on 

the left as shown in Figure 6, or from the drop down menu in the first panel. From the top right options, a user 

can view their user dashboard, change the version and language, and sign in. 

 

Figure 6. Screenshot showing the primary layout of the EDGE App 

Figure 7 shows the main tabs — Design, Energy, Water and Materials. Above the tabs is the Results bar. Some 

panels on the Design tab, and all Measures, have an Options menu. The Options menu can provide several 

functions depending on the panel, such as Detailed Inputs, Calculators, or Document Upload. 

 

Figure 7. Screenshot of the EDGE App showing key features – the Main Pages or Tabs, Results Bar, and the Options Menu 
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4.1. Default Values and User Entries 
The EDGE App is designed with default input values for all fields so that users can model the buildings with 

minimal inputs.  

However, users must note that the EDGE App will use the default values unless a user overwrites them. 

Therefore, attention must be paid to the default values, especially during the certification process, to confirm 

that the assumptions reflect the actual building. 

 

Figure 8. An example of default values and user entries in the EDGE App 

 

Tip: Underlined field names in EDGE are editable.  

 

Clicking on the field name displays the input field. 

 

Figure 9. Most fields in the EDGE App are editable. 

 
Similarly, most efficiency measures are editable. However, their availability may vary per building typology. 

Selecting a measure displays the possible inputs. The value associated with a measure gets overwritten by the 

user input. For example, in the measure EEM01 in Figure 10, a user can overwrite the value 16% with the actual 

value in the project. Some measures will have a calculator. If this is present, you may edit it by clicking the three 
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dots on the right side of the box, and then selecting “calculator”. Project teams shall utilize the calculators 

where applicable. 

  

Figure 10. Most measures in the EDGE App are editable. 

 

4.2. Required Measures  
In EDGE, an asterisk (*) next to a measure indicates that the project team is “required” to enter the actual 

specifications of the measure in EDGE if that measure is present in the project.  

The indication of a “required” measure in EDGE does not mean that EDGE requires that the measure must be 

implemented in the project, or that the improved case must meet or exceed the baseline case to comply with 

EDGE requirements. 

For example, if a residential project needs to report glazing material, the measure must be selected, and the 

actual specifications of the glazing must be entered into the user input fields for the measure regardless of 

whether there is an improvement in glazing specifications or not. 

 

4.3. Results Bar 
The Results Bar in the EDGE App is a summary of the Key Performance Indicators (KPIs) calculated by EDGE. To 

calculate performance against these indicators, EDGE makes assumptions on how the building will be used by 

the occupants. Since the actual usage patterns may differ depending on occupant consumption, the water and 

energy usage and subsequent costs may vary from EDGE predictions. The KPIs include: 

▪ Final Energy Use – the energy consumption (in kWh/month) for the project is calculated automatically 

by EDGE, based on the data entered in the Design section and any reduction achieved through the 

selection of efficiency measures. The results exclude all virtual energy. 

▪ Final Water Use – the water consumption (in m3/month) for the project is calculated automatically by 

EDGE, based on the data entered in the Design section and any reduction achieved through the 

selection of water efficiency measures. 

▪ Final Operational CO2 Emissions – EDGE automatically calculates the CO2 emissions (in tCO2/month) 

based on the final energy use multiplied by the CO2 emission factor for the generation of grid electricity 

and other fuels in the project. The default value for the selected country’s CO2 emissions is shown in the 

Design section but can be overwritten if evidence can be provided to support it. The evidence must be 

from a reliable source such as a peer-reviewed publication from an international organization or a 

specialized government-approved study. The results exclude all virtual energy. 

▪ Final Embodied Carbon – EDGE automatically calculates the embodied carbon (in tCO2e/m2) from the 

building dimensions and the materials selected in the Materials section.  

▪ Final Utility Cost – EDGE projects the monthly cost (in USD/month or local currency per month) for 

energy and water use. The results exclude all virtual energy. 
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▪ Subproject Floor Area – EDGE displays the calculated GIA for the Subproject multiplied by the Subproject 

Multiplier. 

▪ Energy Savings. The results include all virtual energy. 

▪ Water Savings 

▪ Operational CO2 Savings. The results include all virtual energy. 

▪ Embodied Energy Savings 

▪ Utility Cost Savings – EDGE projects the annual savings (in USD and local currency in specific countries) in 

utility bills. The results include all virtual energy. 

▪ Base Case EPI (Energy Performance Index) — energy use per unit area. The results include all virtual 

energy. 

▪ Improved Case EPI (Energy Performance Index) — energy use per unit area. The results include all virtual 

energy. 

▪ Total Building Construction. 

▪ Incremental Cost – Additional cost of implementing the selected efficiency measures (in USD or local 

currency in specific countries). Certain building measures may contribute to a lower overall cost 

compared to the baseline. Therefore, negative incremental costs are possible. EDGE cost data is based 

on average global data and is continuously being refined. It is only meant as a guidance tool for 

comparison between measures. If specific local data is available, the use of it in a more specific financial 

model is encouraged for making financial decisions. 

▪ Increase in Cost (%) 

▪ Payback in Years – Number of years to repay the incremental cost compared to the cost savings of 

utilities. The method used is simple payback based on the capital cost of the measure. 

▪ Number of People Impacted 

▪ Base Case – Refrigerant Global Warming Potential 

▪ Improved Case – Refrigerant Global Warming Potential 

▪ Detailed Results for Typologies – Only applicable to Residential typology. This gets activated when 

multiple typologies are present. 

4.4. Saving a Project 
Users can save their projects within the online EDGE software platform.  

▪ A user account is required to save a project file, and a user must be logged in to save the project.  

▪ Fields marked with an asterisk* on the Design tab are also required to save the project file.  

EDGE can be accessed via handheld devices such as iPhones, Android and tablets. Project teams should exercise 

caution when accessing saved projects via handheld devices as EDGE automatically saves changes to projects 

every three minutes; this time limit does not apply to Certifiers. 

If a user is not active on EDGE for two hours, the system will log the user out. This duration of time for which 

their session stays active while they are away from their computer can be changed by the user in their profile 

settings.  

To create multiple versions of a project with different combinations of measures, it is best to retain your inputs 

by downloading the data into separate PDFs and saving the documents on your computer (File > Download PDF). 

In this way, you maintain one project file for your building within EDGE. 
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Annex 1: Sampling Methodology 
Sampling is a cost-effective method to estimate the characteristics of a population with the minimum amount of 

effort while having statistical confidence in the representativity of the results. For example, to determine the 

rated power of a large number of pumps, it is possible to investigate a representative number of samples, rather 

than the entire population. 

Project teams may follow the requirements from the latest recommendations of the Uncertainty Assessment for 

International Performance for Measurement and Verification Protocol (IPMVP) for sampling section 1.5 sample 

size determination 1.  

Use equations 11 and 12 to determine the minimum number of elements that shall be sampled given the entire 

size of the portfolios. Unless you have evidence, you may assume a Z value for 90% confidence and 10% 

precision and a CV of 0.5. 

Equation 11: 

𝑛0 = (
𝑍 ∙ 𝐶𝑉%

𝑒%
)

2

 

Where:   𝐶𝑉% is the coefficient of variation, the standard deviation normalized by the mean. 

  𝑒% is the desired level of relative precision. For example, 10%. 

  𝑍 is the t-statistic for the desired confidence level. For example, 1.645 for 90% confidence. 

  𝑛0 is the sample size, assuming infinite number of units. 

 

Equation 12: 

𝑛𝑟𝑒𝑑𝑢𝑐𝑒𝑑 =
𝑛0 ∙ 𝑁

𝑛0 + 𝑁
 

Where:   𝑁 is population size, e.g. number of units. 

  𝑛𝑟𝑒𝑑𝑢𝑐𝑒𝑑 is the reduced minimum sample after adjustment.  

 

For example, the minimum sample size of a portfolio with 148 similar buildings, is 46.  

Parameter Value 

𝒁 (confidence level) 1.645 

𝑪𝑽% (coefficient of variation) 0.5 

𝒆% (desired level of relative precision) 0.1 

𝒏𝟎 (Sample size assuming infinite number of units) 67.7 

𝑵 (Total number of units) 148 

𝒏𝒓𝒆𝒅𝒖𝒄𝒆𝒅 (sample size adjusted by the total number of units) 46 

 

1 https://evo-world.org/en/library/download-protocol-documents-mainmenu-en/ipmvp-core-concepts-application-guides-
0/1773-2019-uncertainty-assesment-for-ipmvp-application-guide-in-english  

https://evo-world.org/en/library/download-protocol-documents-mainmenu-en/ipmvp-core-concepts-application-guides-0/1773-2019-uncertainty-assesment-for-ipmvp-application-guide-in-english
https://evo-world.org/en/library/download-protocol-documents-mainmenu-en/ipmvp-core-concepts-application-guides-0/1773-2019-uncertainty-assesment-for-ipmvp-application-guide-in-english
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Annex 2: Core & Shell measures 
Table 3: Allowable improved values when passed to tenants in Core & Shell Projects by category. 

  
Offices Education Healthcare Retail Mixed Use Industrial 

EEM13 
Cooling 
System 
Efficiency 

The minimum efficiency required in ASHRAE 90.1-2016 or local code for a given cooling 
equipment type and capacity 

EEM16 
Space Heating 
System 
Efficiency 

The minimum efficiency required in ASHRAE 90.1-2016 or local code for a given heating 
equipment type and capacity 

EEM18 
Domestic Hot 
Water (DHW) 
System 

Base Case 

The min. efficiency 
required in ASHRAE 
90.1-2016 or local 

code for a given hot 
water equipment 
type and capacity 

EEM22 
Efficient 
Lighting for 
Internal Areas 

Up to of 90lm/W Up to of 70lm/W 

WEM01 
Water-
efficient 
Showerheads 

Up to 7 l/min 

WEM02 

Water-
efficient 
Faucets for all 
Bathrooms 

Up to 5 l/min 

WEM04 

Efficient 
Water Closets 
for All 
Bathrooms 

Up to single flush 5 liters/flush or equivalent. 

WEM08 

Water-
efficient 
Faucets for 
Kitchen Sinks 

Up to  
7 l/min 

Up to 8 l/min 

MEM03 Floor Finish Any valued specified in the legally binding contract 
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Annex 3: Unfinished/Partially finished projects 
 

This applies only to residential typologies (Homes & Apartments). 

Table 4: Improved case values for unfinished or partially finished projects per measure. 

  
Homes & Apartments 

EEM13 Cooling System Efficiency Base Case  

EEM16 Space Heating System Efficiency Base Case  

EEM18 Domestic Hot Water (DHW) System Base Case 

EEM22 Efficient Lighting for Internal Areas Base Case 

WEM01 Water-efficient Showerheads Base case + Penalty factor 

WEM02 Water-efficient Faucets for all Bathrooms Base case + Penalty factor 

WEM04 Efficient Water Closets for All Bathrooms Base case + Penalty factor 

WEM08 Water-efficient Faucets for Kitchen Sinks Base case + Penalty factor 

MEM03 Floor Finish Savings can be claimed 

 

Penalty factor: 

In residential typologies (Homes & Apartments), the Project team cannot claim savings if no installations are 
completed during the audit. Furthermore, with a higher the percentage of unfinished works delivered, the 
probability of negative deviation from the base case increases; therefore, an increasing base case penalty is 
required to minimize the probability of under prediction future water demand. 
 
If the Project team does not provide water fixtures and finishes, or part thereof, the following measures must be 

entered as base case as a weighted average with a penalty factor as outlined below: 

▪ WEM01: Water efficient showerheads 

▪ WEM02: Water efficient faucets for all bathrooms 

▪ WEM04: Efficient water closets for all bathrooms 

▪ WEM06: Water efficient bidets 

▪ WEM08: Water efficient faucets for kitchen sinks 
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Table 5: Base case penalty value for Water Fixtures that are not included in home units. 

% of the units without fixtures Base Case Penalty Factor 

0 < current % ≤ 10 1.1 

10 < current % ≤ 20 1.15 

20 < current % ≤ 30 1.20 

30 < current % ≤ 40 1.28 

40 < current % ≤ 50 1.38 

current % > 50 1.53 

 
All the units with the base case are multiplied by the base case penalty factor. 
 
For example, 58% of homes have kitchen faucets of 5 l/min installed, and 42% of homes do not have kitchen 
faucets installed. Assuming the base case kitchen faucet flow rate is 10 l/min and one kitchen faucet per home, 
the base case penalty factor is 1.38, hence: 
 

Water Fixture Flow Rate Entered in EDGE = 
(58 % x 5 l/min) + (42 % x 10 l/min x 1.38) = 8.7 l/min 
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Annex 4: Primary Energy Demand (PED)  
Project teams interested on aligning with the EU taxonomy compliance may be required to estimate Primary 

Energy Demand. EDGE calculations are based on delivered rather than primary energy. Hence, the spreadsheet 

below can be used for calculating PED from EDGE outputs.  

https://epb.center/support/documents/spreadsheet-exported-energy-explained/ 

If not specified by the EU country or government authority, the following primary energy weighting factors, 

obtained from Appendix B in ISO 52000-1:2017, can be used. 

Table 6: Weighting factors (based on gross or net calorific value). From ISO 52000-1:2017, Appendix B. 

Energy carrier Delivered from distant fPnren fPren fPtot KCO2e 
(g/kW h) 

Fossil fuels Solid 1.1 0 1.1 360 

Liquid 1.1 0 1.1 290 

Gaseous 1.1 0 1.1 220 

Electricity  2.3 0.2 2.5 420 

Delivered from nearby 
    

District heating 1.3 0 1.3 260 

District cooling 1.3 0 1.3 260 

Delivered from on-site 
    

Solar PV electricity 0 1 1 0 

Thermal 0 1 1 0 

Environment Geo-, aero-, 
hydrothermal 

0 1 1 0 

Exported 
    

Electricity  To the grid 2.3 0.2 2.5 420 

To non EPB uses 2.3 0.2 2.5 420 

 

Likewise, if not specified by the EU country or government authority, the following kexp factors, obtained from 

Appendix B in ISO 52000-1:2017, may be used. 

Table 7: kexp-factor 

Description Value 

k exp that is used to control which part of the exported energy is included in 
the energy performance of the building 

1 

 
 

https://epb.center/support/documents/spreadsheet-exported-energy-explained/
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